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Introduction 

Genome research has recently made rapid technical progress.  The primary structures of 

genomic DNA have been determined from prokaryote microorganisms to higher 

eukaryotes.  Concerning rice, which is one of the most important crops, the clarification 

of the genomic structure is being advanced primarily by the Rice Genome Research 

Program, which is a joint research program between two organizations affiliated to  

the Ministry of Agriculture, Forestry and Fisheries (MAFF), namely, the National Institute 

of Agrobiological Sciences (NIAS) and the Institute of Society for Techno-Innovation 

of Agriculture, Forestry, and Fisheries (STAFF-Institute).  Also, with the further 

clarification of the genomic structure, the presence of many novel genes and genes with 
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unknown functions has been recognized.  With this background, the technique called 

“microarray”, which allows rapid functional analysis of a large quantity of genes at  

the transcription level, has recently been developed.  MAFF started the 21st Green  

Frontier Research, “Functional Clarification of Useful Rice Genes Using the Gene  

Expression Monitoring Technique” (referred to as the Microarray Project) in April, 1999.   

As of the year 2000, 60 research groups participated in the Microarray Project, 

including research organizations affiliated to the MAFF, public research institutions,  

national universities as well as private universities and private enterprises.  We have  

created procedures for the preparation and usage of cDNA microarrays used in  

the Microarray Project.  This report presents the basic procedures of microarray  

experiments in this project as well as the know-how obtained through trial and error 

in the process of establishing this project.  It is our hope that this paper serves as a 

“Manual for Microarray Experiments” and a reference for understanding of microarray  

experiments for the researchers who participate in this project and those who are interested 

in microarrays.   

Our group opened a web site of the Microarray Project 

(http://microarray.rice.dna.affrc.go.jp/), which provides information not included 

in this paper such as flow charts of microarray experiments and photographs of  

the instruments used.  This web site may help the readers better understand the contents  

of this paper.   

 

I. What are microarrays? 

 

1. Microarrays and DNA chips  

Generally, DNA directly spotted on (attached to) a glass slide is called a microarray.   
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This paper introduces the cDNA microarrays prepared by spotting cDNA clones  

(or the PCR products of their insert parts) on a glass slide.  The DNA chip is a 

structure that has probes, or oligonucleotides each of which consists of about 25 

bases synthesized on a support such as glass.  (Although the terms “microarray” and 

“DNA chip” are sometimes used synonymously, the DNA chip is not discussed further 

in this paper.) 

 

2. Outline of a cDNA microarray experiment 

There are “two flows” in the microarray experiment, but they later fuse into “one flow” 

(See web site).  The “two flows” are the process of preparing the cDNA microarray and  

the process of treating and processing the sample RNA for analysis, i.e. the process of 

extracting RNA from the subject organism, purifying it, and labeling it with fluorescence.   

In the former process, most operations differ from those in experiments of the conventional 

scale, because a large quantity of DNA clones must be used, which requires the use of new  

devices such as a robot system. On the other hand, the operations in the latter process  

are not widely different both qualitatively and quantitatively from conventional 

experiments of molecular biology or molecular genetics. 

The products of these “two flows” are both tested in one experimental procedure.  That 

is, the microarray prepared in the first process and the target∗ (fluorescence- labeled nucleic 

acid∗∗) prepared in the second process are hybridized. 

Then, fluorescent signals on the microarray are measured with a scanner, recorded 

as image data that reflect the intens ity of the fluorescence, and further converted to  

numerical data.  Eventually, the variations in the transcription level and transcription  

pattern among the samples are compared using these numerical data.   
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∗ In this paper, the fluorescence- labeled nucleic acid prepared from the sample RNA 

is called the “target”.  In association, the cDNA on the microarray is called the “probe”.  

(Some investigators give opposite meanings to these terms.) 

∗∗ As mentioned later in this paper, “to label the sample RNA (labeling)” generally means  

“to synthesize fluorescence- labeled cDNA using the sample RNA and a fluorescent dye by  

the reverse transcriptase reaction”.  Of course, some sample RNAs include mRNAs  

derived from many genes expressed in the analyzed organism so that the cDNA  

fluorescence- labeled here is a group of cDNAs derived from many genes. 

That is to say: 

Target 

= Fluorescence- labeled cDNAs synthesized from sample RNA to be analyzed 

= Group of cDNAs (fluorescence- labeled) from many genes expressed in the organism  

analyzed (See II.4.) 

 

II. cDNA microarray protocols 

 

As mentioned in the introduction, this collection of protocols is made on the basis of  

the actual procedures of our research group with the operations related to the preparation 

and use of Rice 9000 cDNA Array in mind.  Therefore some modifications and 

measures may become necessary in applying them to individual cases.  We would like  

the readers to keep this point in mind as they read this paper. 

 

 

1. Treatment of cDNA for microarray preparation  
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There are many processes for preparation of the cDNA clone necessary for microarray  

preparation including the preparation of replicas of E. coli, hit pick of independent clones  

from replicas of E. coli, plasmid extraction, PCR, purification of PCR products, 

electrophoresis, measurement and adjustment of the concentration, and transfer from  

96MTP to 384MTP.  Although none of them is particularly difficult, a large number of 

clones must be used, and the quantity of DNA contained in each clone is large, so that  

various measures to increase the efficiency and precision of the operations are important.   

Both the manual procedure and the procedure using an automatic system  

(Rail Robot System “Genesis”; Tecan, Ltd.) are described below.  

 

(1) Preparation of E. coli MTP (Micro Titer Plate) 

The start samples are more than 40,000 clones of E. coli into which rice expression 

genes have been introduced.  (Rice expression genes were cloned in plasmid pBluescript, 

and a cell line of E. coli, NM522, was used for the transformation.) 

First, 2 copies each of about 500 independent DWPs∗ (deep well plates), in which all 

original clones obtained by RGP (Rice Genome Research Program) were preserved, 

were prepared using MTPs (2 sets of about 500 copies; referred to as mother copies and 

working copies, respectively).  Manually, 140 µl each of the medium was infused 

into each well of MTP using an electric digital pipette (EP-250/RAININ), M Tray-1 

(Stem/PO1MSD), and a chip for BM-8-1200 (BM Instruments/126-96RS).  The medium  

was 1/2TBE (containing 6% glycerol).  After infusion of the medium, the bacteria 

were seeded using autoclaved 96-unit stamps for replica preparation (MS Machinery) 

(The stamps were sterilized by autoclaving after each seeding of bacteria and 

were not reused after sterilization with a flame.  That is, each independent DWP 

was copied by using the 96-unit stamps for replica preparation once.)   
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For automatic treatment with “Genesis”, these serial processes were carried out after 

using a program installed in “Genesis”, “NewProtocol1”.   

After copying, the lids were applied to the MTPs without sealing, wrapped twice with  

polyethylene films, and incubated statically at 37°C overnight.  The medium is lost 

due to evaporation when the plates are wrapped inadequately.  

The working copies are used in the next hit picking process.  The mother copies are  

preserved at -80°C and are set aside as much as possible.   

[∗The independent type DWPs used were 845-TPS of QSP Co., but this type should 

be avoided if possible.  The use of 2-ml assay block 96 wells (coster/431140) as DWP 

is recommended.  Also, Microtiter plates (Falcon/3072) are used as MTPs.] 

 

(2) Hit picking 

In this process, unique clones to be used for the preparation of microarrays (94 MTPs of 

about 9,000 clones) are selected from the working copies (500 copies) incubated overnight, 

and they are rearranged in MTPs for unique clones (Destination MTPs).  First, 

by the same method as described above, the medium is infused into the Destination MTPs.  

Manually, the wells of the unique clones are touched with a sterilized tooth picks, which 

were then stuck into the Destination MTPs in the right order.   

When the automatic system is used, this process is carried out using a program installed 

in “Genesis”, “Worklist”.  The Destination MTPs are incubated stationarily overnight 

similarly to the method described above. 

 

(3) Plasmid extraction 

This is a process to extract plasmid from each clone of Destination MTPs  

(unique clone MTPs).  In the manual procedure, first, 1 ml each of the medium is poured 
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into DWPs (2 mL Assay Block 96 well (coster/431140)) using a serial infuser 

(Distriman; GILSON).  Then, copies are made from the Destination MTPs incubated 

overnight to DWPs using 96-unit stamps for preparation of replicas, and the DWPs are  

sealed with an Airpore Tape Sheet (QIAGEN) and incubated at 37°C with shaking.  After 

overnight incubation, the DWPs are centrifuged at 3,000 rpm for 30 min 

(Beckman, Allegera6RK), the supernatant was removed, and, with the DWPs kept 

inverted, the remaining medium is absorbed quickly with a Kim Towel.  Plasmid 

extraction was made using a QIAprep96Turbo Mini prep Kit of QIAGEN (See the manual 

of the kit for details).  The extracted plasmid was recovered with DWP (easier to handle  

than the recovery plate contained in QIAGEN’s kit).   

With the automatic system, this process is performed using a program installed in 

“Genesis”, “NewProtocol3”. 

The plasmid of each clone extracted here is used as a template for PCR in a subsequent  

process, but direct PCR from each clone of E. coli can also be made without problems.  

We extract plasmid, because plasmid of each clone is needed for distribution of clones.  

 

(4) Checking of extracted plasmid by electrophoresis 

For electrophoresis, an electrophoresis apparatus for genome analysis of Nihon Eido  

(processing capacity: 8 MTPs/unit) or an automatic electrophoresis system of Tecan Co. is  

used.  One microliter of plasmid was electrophoresed using a 1% agarose gel/TBE buffer. 

 

(5) PCR 

All plasmid extracted as templates for PCR was diluted 10 times, and PCR 

was performed under the following conditions.   

  1) Amplification of the whole length of extracted insert by PCR 
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Since we use pBluescript as the vector, we amplify the whole length of the insert 

by PCR using M13RV primer and M4 Primer (TAKARA) for 1-2 ng of plasmid template.   

The composition of the reaction mixture was as follows: 

10 × buffer    5 µl 

25 mM MgCl2   5 µl 

2 mM dNTP mixture  5 µl 

20 µM M4 primer   1 µl 

20 µM RV primer  1 µl 

Plasmid template (1-2 ng/10-fold dilution of extraction plasmid)  

 x µl (adjusted according to the concentrations and volumes of other reagents) 

Taq polymerase   0.25 µl 

Water y µl (adjusted according to the concentrations and volumes of 

other reagents) 

Total     50 µl 

Note: When PCR is performed using a robot system, 1-2 drops of mineral oil 

is added to the prepared reaction solution.  

 

PCR cycle: 

94°C for 1 min 

94°C for 1 min, 60°C for 2 min, 72°C for 2 min (29 cycles) 

72°C for 10 min 

 

  2) Amplification of 3’UTR by PCR  

Using pairs of upper primer and lower primer designed on the basis of 3’ UTRs of  
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the unique EST clones on Rice 9000 cDNA Array (pairs of the gene-specific primers).   

These primers were used to amplify the 3’UTRs of the EST clones by PCR.   

The pairs of most of the EST clones have already been prepared for creating an rice EST 

map by the RGP (Wu et al. 2002).  We designed the pairs of the remaining EST clones.   

The approximate mean amplification size is 250 bp.  (UTR: Un-Translated Region) 

 

The composition of the reaction mixture is as follows: 

10 × buffer    5 µl 

25 mM MgCl2   5 µl 

2 mM dNTP mixture  5 µl 

20 µM Upper primer  1 µl 

20 µM Lower primer  1 µl 

Plasmid template (1-2 ng) x µl (adjusted according to the concentrations and volumes of 

other reagents) 

Taq polymerase  0.25 µl 

Water  y µl (adjusted according to the concentrations and volumes of 

other reagents) 

Total     50 µl 

 

PCR cycle: 

94°C for 1 min 

94°C for 1 min, 60°C for 2 min, 72°C for 2 min (29 cycles) 

72°C for 10 min 
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(6) Purification of PCR products 

After completion of PCR, PCR products are purified by using a QlAquick 96 PCR 

Purification Kit of QIAGEN (See the manual attached to the kit for details).   

The primers are removed, and the PCR buffer was replaced (the PCR buffers contained 

in the PCR product are considered to inhibit the hybridization reaction if 

microarrays are prepared without purification of PCR products). 

 

(7) Confirmation of purified PCR products by electrophoresis 

All purified PCR products are electrophoresed using 2.5% agarose gel to examine  

whether PCR has been successful.  The above-mentioned electrophoresis apparatus for 

genome analysis of Nihon Eido (processing capacity: 8 MTPs/unit) or automatic 

electrophoresis system of Tecan Co. was used for electrophoresis of these purified DNA 

samples. 

 

(8) Adjustment of concentration of purified DNA  

The concentrations of the purified PCR products are measured by spectrophotometry  

(measuring wavelength OD260), and they are concentrated or diluted to 200 fmol/µl.   

Dilution is made with the elution buffer used for purification, and concentration is made by  

heating at 60°C.  Then, the purified DNA is mixed with reagent D (a DMSO reagent;  

Amersham Pharmacia) at the following ratio (DNA+water: reagent D = 1:1). 

 

DNA   48 µl 

D reagent  162.5 µl 

Water   114.5 µl 
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(9) Transfer of purified DNA samples from 96MTP to 384MTP 

After the adjustment of the concentration, the purified DNA samples mixed 

with reagent D are transferred to 384MTP (GENETYX), because the array-spotter 

is designed to be compatible to 384MTP (GENETYX).  This transfer is performed 

by using a Pipetteman or 96-pin type infusers.   

 

2. Method for using the spotter 

 

Our research group uses Array Spotter Generation III (Amersham Pharmacia). 

 

Preparation before use: 

When the spotter is installed in the clean booth, keep the fan turning to eliminate dust 

in the clean booth.  Also, humidify or dry the spotter to stabilize the humidity (at about 

55% R.H.).  Empty the waste discharge bottle of the spotter.  Then, supplement MilliQ 

water, 100% EtOH, and 0.2M KOH to their respective bottles, and MilliQ 

water to the tank of the humidifier inside the spotter.   

Cautions: 

∗ Avoid drying of the tip of the pen set for the spotter.   

Twelve minute capillary pens are arranged linearly on each pen set.   

Drying of the tips of the pens increases the possibility of clogging.   

∗ Do not use glass slides with slanted bar-code seals or those with damages for 

spotting. 

(1) Open the stopper of the nitrogen tank connected to the spotter.  Then 

supply nitrogen to the spotter 
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by opening the white valve on the side of the body of the spotter.  (Open the stopper 

of the tank until the NITROGEN meter on the side of the body of the spotter 

indicates 9 psi.) (This compressed nitrogen 

is used for the drying of the spotting pins in washing them.) 

(2) Turn on the switch of the vacuum pump and wait until the VACUUM meter 

on the side of the body of the spotter indicates -25 Hg.  

(This negative pressure fixes and holds the glass slide on the slide tray [see below] 

during spotting.) 

(3) Initialize the spotter booting the software “Genration III Array Spotter Control” 

installed in the computer connected to the spotter.  

(Do not touch the mouse or the keyboard during initialization, because it 

may put the arm or other parts of the spotter out of control and 

cause damages to them.) 

(4) When the menu screen appears, turn the “Humidity Control” button on and 

adjust the humidity inside the spotter at an appropriate level (about 55% R.H.). 

(5) Click “Road Slides/Plates” in the left of the screen to show a small 

window.  In this state, the door of the spotter can be opened or closed. 

(Usually, the door does not open when the spotter is in action.) 

(6) Attach the pen set to the arm of the spotter and fix it tightly with 

accompanying screws.  Also, exchange the MilleQ water in the Park Station 

(located to the left of the Slide Tray) about once a week.  (The tip of the pen set 

attached to the arm is kept in the water in the Park Station when the spotter 

is stationary after booting.) 

(7) Put glass slides serially from the farthest left to the right of the Slide Tray.  

(The Slide Tray has 36 glass slide units (4 columns × 9 rows).)  Remove the dust 
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on the glass slides with compressed air by using an air duster or other 

instruments, hold the glass slides with the bar-code side turned to the operator, and 

set them by fitting one corner of each glass slide to the far left corner of each unit.  

(When the number of glass slides for spotting is not a multiple of 9, 

increase the number of glass slides to a multiple of 9 

by adding dummy glass slides.  If the number of glass slides is not adjusted to a 

multiple of 9, the slides cannot be fixed during spotting, 

causing unevenness of the spotting volume or the spot intervals, 

since the vacuum apparatus operates by columns (9 slides).) 

(8) Insert 384-well plates (containing DNA for probe), which have been spun down in 

advance, into the Microplate Elevator on the left side of the interior of the spotter 

serially from bottom up in a manner that Plate A1 is placed in the far right corner 

(with the bar-codes of the plates turned to the back of the spotter).  After 

all the plates have been inserted, close the door of the Microplate Elevator, then 

close the door of the spotter tightly.  

(9) Click the “Ready” button in the small window on the same screen as (4) and (5).   

(10) Wash the pen set by clicking Manual Wash in the right 

of the same screen.  Repeat this washing 3 times. 

(11) Select “Spotting Parameters” from “Options” of the menu on the same screen and 

set the Spot Diameter at 250 µm and the Spot Buffer at 30 µm.  Then, select 

“Spotter Set Up” from “Options” and set the Plate Number at 12, Slide Number at 36, 

Well Sets at 32, and Spot/Dip at 72.   

(12) Start the spotter by clicking the Start button in the left the screen.  If there is an error 

in this process such as that the door of the Microplate Elevator is open, a small 

window (error message) appears on the screen.  After correction 
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of the error, the spotter can be restarted by clicking “Start” in the small 

window.  Spotting of 12 384-well plates to 36 

glass slides (maximum processing capacity on 1 run) can be completed in about 

4 hours. [Note] 

(13) After spotting has ended, wash the pen set by clicking “Manual Wash” in the right 

of the screen.  Repeat this washing 3 times.  Then, click “Road Slides/Plates” 

in the left of the screen, and, after a small window appears, open the door.  

Put the pen set and 384-well plates back, close the door, and 

allow the spots on the glass slides to dry by allowing them to stand in this state for 

about 1 hour. 

(14) After the spots have dried, place the glass slides in a lightproof glass slide case and 

store them in a desiccator (or under dry condition).   

(15) Finish “Generation III Array Spotter Control”, close the white valve and the stopper 

of the nitrogen tank on the side of the body of the spotter, and turn off the switch 

of the vacuum pump. 

 

[Note] Distribution of spots on glass slides:  

The maximum number of spots obtained with this spotter (12 pens) is 4,608 spots  

× 2 repetitions = 9,216 spots per slide.  In this case, the spotting pattern of  

(12 pens) × (2 spottings of the same clone with one pen) is repeated 384 times on 1 slide. 

As a result, the spots are distributed on one glass slide as follows: Twenty-four fields are  

arranged in 12 columns × 2 rows; 384 spots are arranged in 12 columns × 32 rows in 

each field (24 × 384 = 9,216 clones).  In Rice 9000 cDNA Array, which we prepare, 

cDNAs are spotted on the nearly entire surfaces of two pieces of glass slide. 
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3. Preparation of RNA for microarray experiments 

 

There is no particular method for the preparation of RNA suitable for 

microarray experiments.  Although we have not performed exact comparisons, 

we consider that there is no difference in the results of 

experiments according to the difference among extraction methods such as the CTAB 

method, guanidine method, and SDS/phenol method.  What is important is that the RNA 

is purified “to an extent”, i.e. the extracted RNA contains no residual impurities or 

contaminants such as proteins, polysaccharides, and reagents.  That means  

that reverse transcription should be performed by using the isolated RNA.  Even 

when the results of spectrophotometry (values of O.D.260/O.D.280 or O.D.260/O.D.230) 

of the extracted samples may be satisfactory, it is recommended to confirm  

the presence and the quality of RNA by electrophoresis (or using the LabChip 

system of Agilent Technologies/Caliper Technologies).  The use of commercial RNA 

extraction kits (e.g. QIAGEN RNeasy Kit) is also recommended for the extraction 

and purification.    

Either total RNA or mRNA can be used for microarray experiments (See Section 4 

below). Generally, mRNA gives you higher intensity of inflorescent signal than total RNA.   

 

 

4. Target preparation 

 

(1) One color fluorescent method 

Here, a protocol for 1 set of Rice 9000 cDNA Array (two pieces of slide) is described. 
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Preparation before the beginning of experiment:  

Set the temperatures of heat blocks. (37°C, 42°C, 70°C, and 95°C) 

Set an oven for hybridization at 60°C and put it in a sufficiently-humidified state. 

Caution: Dissolve frozen reagents on ice. 

 

1) Prepare the reaction fluid by mixing mRNA (or total RNA) with the reagents below in a 

1.5-ml tube and spin it down. 

 

mRNA (+dH2O∗)  10 µl (contains 2 µg) 

Total RNA (+dH2O∗)     12 µl (contains 40 µg) 

Control RNA    10 µl    10 µl 

Oligo-(dT)25    2 µl   2 µl 

Random Nonamer Primer 2 µl 

Total     24 µl   24 µl 

(∗Adjust the volume to the values as prescribed above by adding dH2O 

depending on the RNA concentration so that the quantities of RNA 

become those shown in the parentheses above.) 

2) Perform pre-annealing at 70°C for 5 min. 

3) Incubate the fluid at 25°C (room temperature) for 10 min and spin it down. 

4) Add the following reagents to the tube of (3), pipette the mixture gently, and spin it 

down. 
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5 × Super Script buffer  8 µl 

0.1 M DTT   4 µl 

dNTP mix   2 µl 

Cy5-dCTP (or Cy3-dCTP) 2 µl 

Super Script II    2 µl 

Total    18 µl 

∗Important: Avoid exposure to light after the addition of Cy-dye. 

∗Important: Add Super Script II last. 

5) Allow the mixture to react at 42°C in the dark for 2.5 hours. 

6) Heat the mixture at 94°C in the dark for 3 min and spin it down. 

7) Add 4 µl of 2.5 M NaOH and mix. 

8) Allow the mixture to react at 37°C in the dark for 15 min. 

9) Add 20 µl of 2 M HEPES, gently pipette the mixture, and spin it down. 

10) Purify the synthesized target by using the QIAquick PCR Purification Kit (QIAGEN) 

or the GFX PCR DNA and Gel Band Purification Kit (Amersham Pharmacia).  Then, 

dry it up with a vacuum concentrator. 

(At this time, protect the vacuum concentrator from light, and keep its interior dark.) 

11) Add 12 µl of dH2O to (10) and thoroughly dissolve it.  Then, spin down the mixture. 

12) Heat it at 95°C in the dark for 4 min. 

13) Cool it rapidly on ice in the dark for 30 seconds, and spin it down (at 4°C). 

14) Add 3 µl of Oligo A80 (1 mg/ml), pipette the mixture, and spin it down. 

15) Allow the mixture to react at 70°C in the dark for 45 min, and spin it down. 

16) Add 45 µl of slightly warmed ExpressHyb buffer (Clontech), mix the content 

gently by pipetting without making bubbles, and spin down the mixture.   
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The final volume of the content is 60 µl.   

 

 

(2) Two-color fluorescent method 

 

 Here, the protocol for 1 set (set of 2 plates) of Rice 9000 cDNA Array is described. 

 

Preparation before the beginning of experiment:  

Set the temperatures of heat block. (37°C, 42°C, 70°C, 95°C) 

Set an oven for hybridization at 60°C and put it in a sufficiently-humidified state. 

Caution: Dissolve frozen reagents on ice.  Prepare tubes for Cy3 and Cy5, 

and perform the respective procedures below using them. 

 

1) Prepare a reaction fluid in a 1.5-ml tube by mixing the following reagents and spin it 

down. 

(Use either mRNA or total RNA.) 

mRNA (+dH2O∗)  10 µl (contains 2 µg) 

Total RNA (+dH2O∗)     12 µl (contains 40 µg) 

Control RNA    10 µl   10 µl 

Oligo-(dT)25    2 µl    2 µl 

Random Nonamer Primer 2 µl 

Total     24 µl   24 µl 

(∗Adjust the volume to the values as prescribed above by adding dH2O 

depending on the RNA concentration so that the quantities of RNA 
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become those shown in the parentheses above.) 

2) Perform pre-annealing at 70°C for 5 min. 

3) Incubate the fluid at 25°C (room temperature) for 10 min and spin it down. 

4) Add the following reagents to 3), pipette the mixture gently, and spin it down. 

5 × Super Script buffer  8 µl 

0.1 M DTT   4 µl 

dNTP mix   2 µl 

Cy3-dCTP∗ (or Cy5-dCTP) 2 µl 

Super Script II∗∗   2 µl 

Total    18 µl 

∗ Avoid exposure to light after the addition of Cy-dye. 

∗∗ Add Super Script II last. 

5) Allow the mixture to react at 42°C in the dark for 2.5 hours. 

6) Heat the mixture at 94°C in the dark for 3 min and spin it down. 

7) Add 4 µl of 2.5 M NaOH and mix. 

8) Allow the mixture to react at 37°C in the dark for 15 min. 

9) Add 20 µl of 2 M HEPES, gently pipette the mixture, and spin it down. 

10) Purify the synthesized target by using the QIAquick PCR Purification Kit (QIAGEN).  

 Pool the samples of Cy3 and Cy5 purified and eluted in the previous sentence 10) in 

one tube.  Then, dry it up in a vacuum concentrator.  

(At this time, protect the vacuum concentrator from light and keep it in the dark.) 

11) Add 9 µl of dH2O to (10) and thoroughly dissolve it.  Then, perform spin down. 

12) Heat the mixture at 95°C in the dark for 4 min. 

13) Rapidly cool the mixture on ice in the dark for 30 seconds, and spin it down. 
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14) Add 6 µl of Oligo A80 (1 mg/ml), pipette the mixture, and spin it down. 

15) Allow the mixture to react at 70°C in the dark for 45 min, and spin it down. 

16) Add 45 µl of slightly warmed ExpressHyb buffer (Clontech), mix the content 

gently by pipetting without making bubbles, and spin down the mixture.   

The final volume of the content is 60 µl.   

 

 

5. Hybridization 

 

Preparation before experiment: 

Perform UV cross- linking of microarrays (50,000 µJ/cm2) before hybridiation.  

(Whether performing UV cross- linking or not is reported to have little effect 

on the experimental results.)  Use cross- linked microarrays as soon as possible and do not 

store them long.  Confirm being set an oven for hybridization at 60°C and being put it in a 

sufficiently-humidified state. 

 

(1) Remove dust from the surfaces of glass slides and cover glass with compressed air (air 

duster).  Drip half the final volume mentioned in the sections 4. (1) 16) and 4. (2) 16) 

on an end of the first glass slide and apply the cover glass gradually from this end.  

(Usually drip 30 µl from 60µl of the final volume onto glass slide.) 

(Cautions: Pay sufficient attention not to let bubbles in.  Also, do not 

move the cover glass once applied.) 

(2) Drip the remaining half volume on the second glass slide and similarly apply the cover 

glass.   
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(3) Place Kimtowel (a kind of paper towel) or sponge in a sealable container such 

as Tupperware and let it sufficiently absorb water warmed to about 60°C.  

Place the mount above it and put the glass slides with the cover glass on.   

Tightly apply the lid of the container and seal it.   

(4) Perform hybridization for 4 hours at 60°C in the dark in an oven for hybridization in a 

sufficiently-humidified state.  

 

 

6. Washing of glass slides 

 

Preparation before washing: 

Warm two washing fluids (1 × SSC, 0.2% SDS and 0.1 × SSC, 0.2% SDS) to 55°C in 

advance. 

Set an oven for hybridization at 55°C. 

(1) Place a sufficient volume of 1 × SSC, 0.2% SDS warmed to 55°C in a black wash box 

(= a light-proof box with a lid for washing equipped with glass slide racks). 

(2) Place 1 × SSC, 0.2% SDS warmed to 55°C into a wide-mouthed container such 

as Tupperware.  Immerse the glass slides in this fluid and remove the cover glass and 

quickly insert them into the rack in the wash box described in (1).  At this time,  

place the glass slides at even intervals as much as possible in the rack.  Apply the lid, 

and allow the washing fluid to shake gently at 55°C in the dark for 10 minutes. 

(3) Place 0.1 × SSC, 0.2% SDS warmed to 55°C into another wash box, 

quickly transfer the rack described in (2) into it, apply the lid, and 

allow the wash fluid to shake gently at 55°C in the dark for 10 minutes.   
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(4) Place 0.1 × SSC, 0.2% SDS warmed to 55°C into another wash box, 

quickly transfer the rack described in (3) into it, apply the lid, and 

allow the wash fluid to shake gently at 55°C in the dark for 10 minutes.   

(5) Place 0.1 × SSC at room temperature into another wash box, 

quickly transfer the rack described in (4) into it, and 

wash the glass slides by moving the rack up and down about 10 times in the fluid. 

(6) Place 0.1 × SSC at room temperature into another wash box, 

quickly transfer the rack described in (5) into it, and 

wash the glass slides by moving the rack up and down about 10 times in the fluid. 

(7) Place MilliQ water at room temperature into another wash box, 

quickly transfer the rack described in (6) into it, and 

wash the glass slides by moving the rack up and down about 5 times in the water. 

(8) Remove the water on the glass slides by centrifuging in a 

centrifuge for plates adjusted to room temperature at 900-1,000 rpm for 4 minutes.  

Perform the scanning thereafter.   
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7. Scanning 

 

Scanning by Array Scanner Generation III 

A cartridge for slide glass and a magazine for setting the cartridge are attached to this  

Scanner (Molecular Dynamics manufactured by Amersham Pharmacia) 

(refer to the photographs on the Web site).  Scan slide glass using these devices.   

1) Turn the scanner and then the computer on to start them up. 

2) Start up software "Array Scanner Control" to initialize the scanner. 

3) Take the magazine out of the scanner after the initialization has ended. 

4) Remove dust on the slide glass using an air-duster. 

5) Keep the slide cartridge with a hand with the Q-shape notch towards you with the slide  

stopper to the left.  As pressing the spring just in front of the stopper, set the slide glass at  

the fixed position.  Here, keep the spot surface upwards, and keep the barcode to the  

opposite side of the Q-shape notch.   

6) Insert the cartridge into the magazine with the spot surface upwards.  It is desirable to  

insert the cartridge from the bottom stage of the magazine in the order of sample numbers  

(because scanning begins with the bottom stage of the magazine).   

7) i) Scanning in the manual mode 

Set the “Scanner Mode” to ‘Manual’ in the initial screen of “Array Scanner Control.”   

Select “Scan Setup” in the “File” menu.  In this screen, select “Full Slide” from “Slide  

Area,” and then set “Scan Parameters” (the wavelength to be used, the scope to be scanned,  

the slide glass to be scanned, and so on).  Clicking the “Done” button brings you to the 

initial screen.  Click the “start” button.  As the saving window is displayed, enter a file  

name with which you save image data and click the “OK” button.  Scanning will start.   

ii) Scanning in the automatic mode 
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Set the “Scanner Mode” to ‘Auto’ in the initial screen of “Array Scanner Control.”  When  

the start button is clicked as it is,scanning begins.  In this case, the spots on the whole  

glass are automatically scanned by two wavelengths (for two colors of Cy5 and Cy3).   

Image data are also automatically saved in a file with the name of the barcode number.  In 

case the barcode cannot be read, the file is named as “Slide xx” (meaning the slide scanned 

as the xx-th piece).   

8) Image data taken by the one-dye method are saved in two folders (each folder contains  

two files) and two files with no folder.  First of all, this section mentions the two folders of  

xxx.dir and xxxb.dir.  Folder xxx.dir contains the two files of xxx.ds and xxx_L_1.GEL.  

On the other hand, folder xxxb.dir contains the two files of xxxb.ds and xxx_R_1.GEL.   

This is because a piece of slide glass is scanned on the left side and on the right side  

separately.  xxx_L_1.GEL corresponds to the image of the left side, and xxx_R_1.GEL to  

the image of the right side.   

The two files with no folder are xxx.ds and xxxb.ds.  These are quite the same files as  

those with the same names in the folders.   

(For reference: When image data taken by the two-dye method are scanned, the data are  

scanned in the order of Cy3 and then Cy5 in the automatic mode, so the image of Cy3 is  

saved in xxx_L_1.GEL and the image of Cy5 in xxx_L_2.GEL.  The data are scanned in  

the order of Cy5 and then Cy3 in the manual mode, so the image of Cy5 is saved in  

xxx_L_1.GEL and the image of Cy3 in xxx_L_2.GEL.   

If using software “Image Quant,” you can view an image of the left side in xxx.ds and an 

image of the right side in xxxb.ds.  Either image is viewed in two colors overlapped each 

other.)   

9)After the scan has been completed, exit “Array Scanner Control” and turn the scanner off.   
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(2)  Scanning by FLA-8000 

Using FLA-8000 (a scanner manufactured by Fuji Film) makes it easier to set slide glass  

than using Array Scanner.  Simply insert some pieces of slide glass into the slide carrier 

(that can set up to five pieces of slide glass) and set the slide carrier on the main unit.   

1) Turn the scanner and then the computer on to start them up. 

2) Start up software "Image Reader FLA-8000 v1.0" to warm up the scanner. 

3) Take the carrier for slide glass out of the scanner, and put the carrier on the handle side. 

4) Remove dust on the slide glass using an air-duster.  To set a piece of slide glass on  

the carrier, grasp the end of the barcode side with the spot surface upwards and 

insert the piece into the carrier.  Next, set the carrier inside the scanner properly and 

close the covering of the scanner.   

5) Set “Scan Conditions” (namely set “Resolution” to ‘10 mm’; “Scan Mode” to ‘High 

sens.’) and “Area” (Push “Max” button on to set the maximum area).  Select wavelength 

of “laser” and the number of pieces of slide glass to perform scanning.  

(You can perform “pre-scan” to confirm the quality of the array image beforehand.)  Click  

the “Scan” button and start scanning.  After the scan has been completed, click the “Save” 

button to save image data.   

6) For each image to be saved, a file and a folder are created together as a pair.   

This file contains backup information (or setup information), and the file name is  

“the folder name of the pair .set”.  On the other hand, the folder contains the three files of   

xxx-x.img, xxx-x.inf, and Info.set.  The “-x” of xxx-x.img and so on displays the  

wavelength of the laser used for the scan.  For example, when the sample has been 

scanned using the wavelengh of Cy5, the file name is xxx-640.img and so on.   

(For reference: By using “Convert to TIFF” of the “File” pull-down menu of  

“Image Reader MAS-0,” which is an old version of “Image Reder,” an img file can be  
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converted into a tif file.  ) 

7) After the scan has been completed, exit “Image Reader FLA-8000” and turn the scanner 

off.   

 

 

8. Quantification of Image Data 

 

This section describes the usage of the three types of quantification software that have been 

used by our group.  A detailed operation guidebook in Japanese and an operation manual 

in Japanese (including detailed operation methods) are attached to the software of section 

(1).   The software of section (2) and the other software of section (3) provide only an 

operation manual in English, so no manual in Japanese has been prepared (as of the end of 

year 2000).   

[The definition of the terms used in this chapter.   

Template: A frame determining an area for measuring and quantifying the intensity of  

fluorescent signal.   

Gene Information File: A file containing the numbering of clones on a Microarray, clone ID, 

accession No. and so on.] 

(1) ArrayGauge (for Windows; Fuji Film’s analysis software) 

To quantify the data obtained by the rice 9000 cDNA array manufactured by STAFF 

Laboratory, install the template for the rice 9000 array and the gene information file related  

to the spot on the array in advance.  For the details of the installation, contact  

Fuji Film’s person responsible for ArrayGauge.   

If creating a new template individually, refer to the operation guidebook and operation 

manual of this software (both of them written in Japanese) because the detailed 
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operation procedure is described in them.   

 

1) Start up ArrayGauge.  The items of the analysis procedure are displayed in the upper  

portion of the screen as a flow chart.  Go on the analysis according to this order.   

The item currently analyzed and the next item (the lowest button of the left panel) 

are also displayed in the left panel of the screen.   

(a) For img file: Click the “Image” icon button in the upper portion of the screen, and select 

an img file using the “Trimming” button in the left panel of the screen.  A small window  

(“Trimming”) will be displayed.  While dragging the green perpendicular at the right end 

of the gradation adjusting graph (“Range Scope”) in the lower portion of this small window, 

adjust the shade and the color tone of the image.   

(Note: Even if the gradation or shade of the image is changed here, the original fluorescent 

intensity is not changed.  Therefore the final measurement results are not influenced.)  

→ Go to the “Display” icon button. 

(b) For tif file: Click the “Image” icon in the upper portion of the screen, and select 

a tif file using the “Trimming” button in the left panel of the screen to open the file.  As a 

small window will be opened, adjust “Range Scope” in this window and save the file  

as another name. → Go to the Display icon button. 

2) Click the “Display” icon at the lowest portion of the left panel of the screen, 

or the “Display” icon in the upper portion of the screen.  Confirm that “Scale” has been 

“exponential” in the left panel.  To perform a fine adjustment for the array image, 

while dragging the green perpendicular of the gradation adjusting graph in the lower  

portion of the left panel of the screen, adjust the shade and color tone of the image.   

(Note: Even if the gradation or shade of the image is changed here, the original fluorescent 

intensity is not changed.  Therefore, the final measurement results are not influenced.) 



 30 

When you have selected an image file that has not been analyzed yet from the folder icon, 

click the “Range Scope” button of the left panel to display the “Trimming” window, and 

adjust gradation using the method mentioned at step 1).  Next, perform a fine adjustment 

additionally using the method mentioned at step 2). → Go to the Measure icon button. 

3) Click the Measure icon in the lower portion of the left panel of the screen, 

or the “Measure” icon in the upper portion of the screen.  If you select a template for  

the rice 9000 array using the “Select” button in the left panel and click the OK button,  

the selected template is displayed on the array image.  Be careful about the  

correspondence of the image data and the template.   

(For example, if a template for the second slide glass is used for the image data of the first 

slide glass, it is not possible to attach cDNA information for the first slide glass to the text 

data to which quantification has been completed afterwards.  Be careful with this case  

because a template is to be attached again and you should perform the procedure from  

step 3) again.) 

4) To move the template and align it roughly with the position of the spot, use the leftmost  

two buttons of the three square “Fitting” buttons horizontally arranged in the left panel 

and the hand button in the upper portion in the left panel.  Click the “Auto Option.”   

Then, a small window (“AutoFitting Parameters Option”) will be displayed.  In the  

window, set the “Block Alignment Type” to ‘independent’ and the “Spot Alignment  

Sensitivity” to ‘5’.  Select the “Spot Appearance” according to the state of spotting, 

set the “Centering Prameter” to ‘2’ and click “Auto”.  By this operation, the template is  

adjusted so that it is automatically fit to the spot.  Manually correct the location 

where the template is not fit to the spot, (repeat Auto Option again in certain 

circumstances), finally fit the template to all of the spots completely.   

(Option 1: Set the positive control spot at this stage.  Use the “Choice” button in the  



 31 

left panel to select spots for positive control.  Next, click the “Attribute” button to change  

the attribute of the spots to ‘Control’.  The color of the template of positive control spot 

will change into green; Option 2: Use the “Background” button in the left panel at this stage  

to set the area for global background.  Refer to step 10) ). 

→ Go to the Analysis icon button. 

5) Click the “Analysis” icon in the lower portion of the left panel of the screen or the  

“Analysis” icon in the upper portion of the screen.  When an image file is analyzed,  

three windows (in short, the array image already opened at step 5, a table of 

measurement results for spot fluorescent intensity, and a pattern image indicating  

the distribution of concentration for each spot) appear on the screen.  When two  

image files are analyzed, seven windows (in short, two array images, two pattern 

images corresponding to the respective images, a measurement results table of 

spot fluorescent intensity, a “Compare” window in which the pattern images are compared, 

and a scattering plot in which two sets of measurement results are compared) appear 

on the screen.  The spot and data on each window are mutually liked.   

(There is no link, however, in the directions from each point of the scattering plot to other 

windows.) 

6) To add the cDNA information on the array to the table of measurement results, first of all, 

make the window of the table of measurement results active and click the “cDNA info.” 

button in the left panel.  A small window (“cDNA Info”) will be displayed.  Click the  

“select” button in the small window.  Select the file corresponding to the table of 

measurement results (for example, select the file “Rice9000FullAllay1-stInfo” for the  

results of the ‘first slide’ of a pair of rice 9000 array [a ‘first slide’ and a ‘second slide’]  

from the gene information files installed in advance, and click the “OK” button.   

The items contained in the information file are displayed on the left side of the small 



 32 

window.  First, select only the “Element No.” in the window, and click the “Add” button  

to move the “Element No.” to “Index Matching Information”.  Next, click the “Add all” 

button to move the remaining gene information to the “Gene Information to Display” box.   

Finally, click the “OK” button.  The gene information corresponding to each spot 

in the table of measurement results will be displayed.   

7) Click the “Measure Option” button in the left panel.  A small window (“Measure  

Option”) will be displayed.  Background or normalization can be set from this window  

(Background can be also set using “Range Option”.  Refer to step 10) ).   

(Note: Global normalization is generally performed as normalization.  Normalization 

cannot be performed successfully in many cases using positive control.) 

8) Make the table of measurement results active and click the “Table Option” button 

in the left panel.  A small window (“Table Option”) will be displayed.  In this window, 

measurement results and clone information can be arrayed again in the order of ‘No.’ or 

‘Index’ (only ascending order available for both the items), ‘Dens.’ (in the descending order 

of measured values), or ‘Ratio’.  For ‘Ratio’, data ratio between a sample and another 

sample can be displayed in descending order (by clicking the “Ratio (down)” button) or in 

ascending order (by clicking the “Ratio (up)” button).  Moreover, by selecting the “All” 

button using “List Amount”, the data and information of all clones can be displayed in 

descending order from the maximum data.  On the other hand, by selecting the “Top” 

button and then entering the number of the sets of data you want to display, data and 

information corresponding to this number can be displayed in descending order from the  

maximum data.  When the “Selections” menu is selected using “List Choice”, only the  

clones that ‘OK’ has been entered in the “Status” box of the results table are listed.  

(To enter ‘OK’, simply click the “Status” box of each clone.) 

9) Make the array image active and click the “Range Option” button in the left panel.   
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The cursor changes into a cross, so click any spot on the image with the cursor.  A small 

window (“Range Option”) will be displayed.  In this window, the background area and 

measurement concentration area can be adjusted.  Our group uses the settings mentioned 

as (a) below to perform analysis.   

(a) Change the “Display” mode into “OutLine”, and leave the blank boxes of 

“Limit Density Range” as they are (without entering a check mark).  Click the blank field 

of “Peak Noise Reduction” to enter a check mark.  (Leave the setting of the “Limit  

Density Range” 0%).  Select the “Local” button on the “Background”, and set 

“BG Thickness” to ‘3’ and “BG Space” to ‘0’.   

(Note: To select “Global Background” here, it is necessary to set a background area at step 

5). )  

→ Go to the “Annotation” icon or the “Save” icon.  (In this latter case, skip step 10) and 

go to step 11). ) 

(b) Change the “Display” mode into “OutLine”, and click the blank boxes of 

“Limit Density Range” and “Peak Noise Reduction” to enter check marks.  

(Leave the setting of “Limit Density Range” 0%).  Select the “Local” button 

on the “Background”, and set “BG Thickness” to ‘3’ and “BG Space” to ‘0’.   

(Note: To select “Global Background” here, it is necessary to set a background area at step 

5). ) 

→ Go to the “Annotation” icon or the “Save” icon.  (In this latter case, skip step 10) and 

go to step 11). ) 

10) Click the “Annotation” icon in the lower portion of the left panel of the screen 

or the “Annotation” icon in the upper portion of the screen.  By selecting the “A” icon 

in the left panel, characters can be entered on the array image.  By selecting the “arrow” 

icon, an arrow can be entered. → Go to the “Save” icon. 
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11) Click the “Save” icon in the lower portion of the left panel or the “Save” icon 

in the upper portion of the screen.  Here, make the table of measurement results active, 

and click “Export” to save the table in the text format.  Save the array image as an img file  

by selecting “Save” (You can save the array image as a tif file or a bmp file  

by selecting “Export”). 

 

(2) MicroArray Suite (for Mac, M&S Instrument’s analysis software) 

This software can analyze the data of the tif file format.   

 

Preparation: Create a gene information file for each spot (See 4) (b)).   

 

1) Work before quantification: In some cases, a fluorescent image of microarray experiment  

includes an area (or areas) with extremely high fluorescent intensity unnecessary for 

analysis in a portion such as a high area of the background (many of such an area are found 

around the outer edge of the slide glass) or the barcode portion.  Hence, for using  

MicroArray Suite, cut a spot signal area out of the array image to create a new file.  

(Quantification will be difficult unless this work is performed.)   

a) Start up MASbata21, and select the tif file of an image you want to analyze to open 

it from the “File” menu.  Select “Normalization” from the “Enhance” pull-down menu  

to adjust contrast.  Select the loupe icon in the “ROI” window (the image is expanded 

by clicking it and reduced by clicking it with pressing and holding the “Option” key), and 

adjust the image size so that the whole slide glass can be viewed.  Next, click the “Cut” 

icon and enclose the portion of the image you want to cut out.  By selecting “Crop image”  

from the “Edit” menu, only the portion of the image you want to cut out is displayed. 

b) T minimize the value of dust or dirt on the glass, select “Median Filter” from  
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the “Enhance” menu, and apply the filter twice in 3×3 pixels.  Be careful about 

applying the filter many times because this influences the measured value of the fluorescent 

intensity of the spot.   

c) Select “Save As...” from the “File” menu, and save this ‘cut-out’ image as another file  

name.  This image is used for quantification nalysis afterwards.  Although this image file  

is also in the tif format, the shape of the icon is different from that of the tif file of  

the original image.   

(Note: If this ‘cut-out’ image is saved using the same file name that the original image has,  

the original image is lost.) 

(For reference: When this image is saved, if an extender of .tif is attached 

after the file name, the image can be opened even in the Windows environment.) 

d) Exit MASbata21.  (After this, start up this software again to perform quantification.) 

2) [Quantification starts from here.] Start up MASbata21 again, and select the tif image  

file saved at step 1) to open it.  Select “Normalization” from the “Enhance” menu and 

adjust contrast.  Select “invert” from the “Enhance” menu, check the “invert CLUT,” and  

click “OK”.  This operation allows the signal to be displayed in black and the background 

in white.  (If you perform the same operation again, the colors of the image are inverted.) 

3) Select “Place Grids” from the “Ext.” menu.  The grid last used at the previous time and 

a small window (“Grid Setup”) will be displayed.   

4) To create a new grid, follow the procedure below.   

(a) When New is selected in the small window, a still smaller window (“Confirm Save”) 

is displayed.  In the window, select “No” and click “Clear Grids” in the lower portion 

of the array image.  The grid displayed so far will disappear on the screen.   

(b) Select and set up the gene file you want to use from “Load Gene Library” 

in the “Grid Setup” window.  Next, set up four respective items (“Super Grid Rows”, 
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“Super Grid Columns”, “Sub Grid Rows”, and “Sub Grid Columns”) according to  

the pattern of spotting.   

[Example: If DNA has been spotted to the whole surface of a piece of slide glass like  

the rice 9000 array, set “Super Grid Rows” to ‘12’ (the number of field rows), 

“Super Grid Columns” to ‘2’ (the number of field columns), “Sub Grid Rows” to ‘12’ 

(the number of rows of spots in a field), and “Sub Grid Columns” to ‘32’ (the number of 

columns of spots in a field).  For spotting pattern or field of the rice 9000 array, refer to  

the note at the end of “II. 2. Spotter Usage” in this protocol.  ]    

If the cursor is drugged from the top left spot on the array image so that spots for a field 

is enclosed, the grids for the remaining fields are also displayed.   

5) Fit grids to spots one by one.  All grids are linked each other.  So, when a grid of the  

left side is moved, the grids of the right side are also moved together.  When a grid of the  

upper side is moved, the grids of the lower side are also moved together.  Hence, fit 

grids to spots in the order of left grid to right grid and upper grid to lower grid.   

To remove the link between a grid and another gr id, first move the cursor to the field 

you want to remove the link, and click the field with pressing the apple mark. Only the grid 

will be changed into blue, and the link can be removed.  (Here, the shape of the cursor 

changes into a shape like a chain).  To restore the link, perform the same operation.  In 

addition, the “Grid Cell Mode” button is prepared in the lower portion of the image  

window.  In this mode, all the cells enclosing the spot of the same position in respective  

fields are linked each other.  So, if a cell is moved, all the other cells are moved  

the same way.  To remove the link, perform the same operation as that mentioned above.   

After you have removed the link of a grid, be sure to restore the link.  When 

you want to change the size of a field, align the cursor with the outer frame of the field.   

The cursor will change into an arrow, so drag the arrow to adjust the size of 
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it.  Be sure to save the created grid as a name.  After grids have been fitted to spots, 

click “OK” on the right side of the lower portion of the image window.   

6) Select “Process Arrays” from the “Ext.” menu and check the contents of the items in 

“Place Grid Setting”.  Set “Target Size” in “Processing Specifics” to ‘10 pixels’, 

“Type” to ‘Thresholding’, “Weight” to ‘3’, “Background Subtraction” to ‘Local’, and 

“Intensity Average Within” to ‘Target’.  Moreover, confirm that “Target Analysis” has  

been set as ‘Target Detection Only’, and press “OK”.  (Here, be sure to confirm that  

no Japanese FEP is active.  Note that if Kotoeri or ATOK is still active, this software may  

be forcedly shut down.)  Then, three windows (the originally displayed image, a window  

where an image file called “Processing Result” is overlaid on a grid, and a table of 

measurement results called “Sample Intensities”) will appear.   

7) When the Display Array Data mode is selected from the “Ext.” menu,  

two windows (“Color Image” and “Sample Intensities”) are opened.  In the “Color Image” 

window, key codes correspond to the keyboard (For example, when ‘H’ is pressed, the help 

of the key codes are displayed.)  Up to 100 sets of data of clicked spots are displayed in 

“Clone Info”, so only the data of interesting spots can be picked out.  By pressing ‘Q’ or 

double-clicking, you can exit from the “Display Array Data” mode.  Unless you exit  

the “Display Array Data” mode, other work (for example, save a file) cannot be performed.  

Moreover, note that once you exit the “Display Array Data” mode, you cannot 

enter the mode again.   

8) To save necessary data using “Save As...”, apply names different each other to all  

files you want to save.  All files are saved in the format dedicated to MicroArray Suite.  

(The "cut-off image" ,or a tif image file created at step 1) is left as a tif file.  Refer to 1) d)).  

“Sample Intensities” can be saved in the text format separated with tabs.  So, when 

“Sample Intensities” is saved as using “Save As...”, if a txt extender is attached, the file can 
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be also opened in the Windows environment.  Open and analyze this text file with  

table calculation software such as Microsoft Excel.   

9) As mentioned above, software MicroArray Suite introduced in this section creates  

many windows from a microarray image file.  Accordingly it is safer during work to  

analyze the image while saving each window as a file one by one.  (For example, when 

you want to exit this software and select “Dispose all windows” from  

the “Window” pull-down menu, all the windows open there are closed.  In short, 

any window in which data have not been saved yet is also closed.) 

 

(3) ArrayVision (for Windows, Molecular Dynamics’ analysis software) 

 

1) Start up "ArrayVision."  When the rightmost icon displayed in the upper portion 

of the window (the “ArrayMacro” button) is clicked, two small windows appear.  

One is the “Run: [ArrayMacro]” window, which is shown on the right side of the screen 

(Here “[Display Format]: Change display format” is displayed.  In this window, each 

stage of the procedure for quantification is displayed.)   The other is  

the “Run[Display Format]” window, which is shown at the center of the screen.  Set 

“Image type” to ’16 bits’ (default), “total # of channels” to ‘4’ (default), “total # 

of views” to ‘1’ (default), and click “OK”.   

2) In the “Run: [ArrayMacro]” window, “[ARV Analysis setting]: ArrayVision channels and 

measure selection” is displayed.  The “Run Macro” window appears at the center 

of the screen when the “Run[Display Format]” window has disappeared.  Set 

“Analysis type” to ‘Expression’, “Arrays and Channels” in “Arrays/Templates”  

to ‘single array’, “Template mode” to ‘single’, “Element value” in “Quantification”  

to ‘Dens x Area’, “Background” to ‘average’ and check all the check boxes in 
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“Measure selections”.  Then, click “OK”.   

3) In the “Run: [ArrayMacro]” window, “[Loading Image Set]: Load multiple images  

from files.” is displayed.  The “Retrieve image set” window appears at the center 

of the screen when the “Run Macro” window has disappeared.  Select  

the GEL file you want to analyze from the files displayed in the left box of this window  

and press the “Add” button to display the file in the right column (“images  

to load”).  Click the “OK” button. 

4) When a small window called “Loading Image” (displaying that the file is being loaded)  

has disappeared, the “Image view” window appears.  In this window, the GEL file (= an 

array image) you selected above is displayed.  In the “Run: [ArrayMacro]” window,  

the sentence of “[Pause]: Cause macro execution ... (the following is omitted)” 

and the “Stop” icon are displayed.  The “Visuals” window is displayed behind these  

windows.   

5) Click the third icon, “Histogram”, in the upper left portion of the “Visuals” window  

(hidden behind the “Run: [ArrayMacro]” window).  A histogram indicating the pixel 

distribution of fluorescent signal is displayed in the right half of the “Visuals” window  

(= the LUT map).  Adjust the image to the most appropriate contrast, while moving the  

diagonal line (in brown) drawn from the bottom left corner to the top right corner of the  

LUT map in the direction of the X axis by drugging both the ends of the line, and viewing  

the image in the “Image view” window. (Appropriately adjust the magnification of the  

image in the “Image view” window by selecting “magnification” from the pull-down 

menu of the icon (in green and red) at the top left corner of the “Image view” window.) 

6) Click the “Resume” button (in green, blinking) below the “Stop” icon in the “Run: 

[ArrayMacro]” window.  The “Template Definition [Untitled]” window will newly appear 

at the center of the screen.  Create a template in this window.  
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(The template is a frame applied to the spot on the array image to measure and 

quantify signal intensity.) 

7) i) When an appropriate template has been saved previously:  

Select “Open” from the “File” pull-down menu at the top left corner of the  

“Template Definition” window.  Template files saved previously will appear.  Select 

a template you want to use and press the “OK” button.  The template (many red circles) 

will appear on the array image of the “Image view” window.  (If the template is not fit to  

the spot on the image, select the “Alignment” menu in the “Template Definition” window, 

and apply the template to the spot according to the procedure described  

on and after step h) below.) 

ii) When a template is newly created: 

a) Select the “Layout” menu from the menus in the “Template definition” window.   

Click the “Change” button in the “Layout” menu.   

b) Three items will appear.  Set the “Field” selection to ‘multiple’ and the “Layer 

selection” to ‘1’.  Fill in the “row” with the number of fields (, or the number of used  

pens) and the “column” with the number of spot columns per field. Click the “OK” button.   

c) Return to the “Layout” menu mentioned at step a).  Fill in the “Row” with the number 

of all spot rows and the “Column” with the number of all spot columns. 

d) Measure the diameter of the spot on the array image.  A distance between a point and 

another point can be measured by drawing a straight line with the cursor when the “A—B” 

button (or a button for measuring a distance) in another small window (“Layout” tool box) 

is pressed.  (By drugging the cursor from the start point and then releasing it 

at the finishing point, the distance between those two points is measured.)  First, 

measure the diameter of the spot.  The diameter is displayed in the box of “Rows” or 

“Columns”.  Enter the value on the box of “Diameter” from the keyboard. 
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e) Next, measure the distance between a spot and another spot (interval) in the row and 

column directions.  (The interval of row means the distance from the top to the top 

(or the bottom to the bottom) of the upper and lower spots adjacent each other.   

The interval of column means the distance from the left end to the left end (or the right 

end to the right end) of the right and left spots adjacent each other.)  The intervals of row  

and column are automatically entered in the boxes of “Rows” and “Columns” respectively  

by measuring it the same procedure as that mentioned at step d).   

f) In addition, select a circle in the “Element” box and click the “Create” button. 

g) The Element Starting Position window will appear.  Click the top left spot 

of the image in order to determine the start point of a template.  A template (many red 

circles) will appear in the image.   

h) [Aligning the template with the positions of spots starts here.  ]   

Select the “Alignment” menu (a menu to align the template with the spot) from  

the menus in the “Template definition” window.  A green square frame (hereinafter called 

a green frame) will appear outside of the template on the array image.  The “Layout” tool 

box change into the “Alignment” tool box.   

i) First, drug the right and left sides and the top side of the green frame (the cursor will 

change from an arrow into a bi-directional arrow) to adjust the template column so that it 

is aligned with the column of the spots.   

j) Next, drug the bottom side of the green frame while pressing the control 

key on the keyboard to adjust the template of the bottom row so that it is aligned 

with the spots of the bottom row.  (By drugging the bottom side of the green frame  

while pressing the control key, a template corresponding to the number of fields  

is placed.  By simply drugging the bottom side, the template expands equally.) 

k) The range of the templates enclosed by the green frame can be easily changed.  



 42 

When the cursor is aligned with a template and the template is clicked, the green frame  

encloses only the template.  When another template is additionally clicked with the shift 

key pressed and held, a green frame enclosing the clicked two templates is created.  By  

the same procedure, the green frame can be changed into any square and the template can 

be enclosed.   

Besides, when you want to move all templates in the green frame as they are, align the  

cursor with the top left corner of the green frame (the cursor changes from an arrow into a 

cross) and drug the cursor.   

In addition, when you align the cursor with the top right corner of the green frame (the  

cursor changes into a bi-directional arrow like a bow and drug the cursor), all the templates  

in the green frame rotates around the top left corner of the green frame as an axis.   

It is also available as another method to adjust the template in the green frame to the  

position of a spot by aligning the cursor with one of the templates at the four 

corners of the green frame (the cursor changes into a V-shaped cursor).   

l) If the signal of the spots in the green frame is generally strong, template and spot 

in the green frame are automatically aligned each other by roughly aligning the template  

with the spot by the procedure described above and then by clicking one of the  

“Auto alignment” buttons in the “Alignment” menu.  (If the signal is not strong, however, 

“Auto alignment” may provide rather bad alignment.  If you do not satisfy the result 

by auto-alignment, you can undo the auto-aligning when you push the “Undo” button just 

after performing the “Auto alignment”)   

m) If the template and the spots are still not aligned each other, click the “Move individual  

template” icon (an icon carrying both a circle and an arrow) in the “Alignment” tool box 

displayed on the same screen, and then drug each template to align it with the spots.   

n) Select the “Label” menu from the “Template definition” window.  In this window, 
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a number can be assigned to each spot.  (In short, this is the setting for corresponding  

the array of each spot to the array of quantification data.)  Using the left icon 

allows you to ‘assign each number in the row direction and column 

direction.’  Using the center icon allows you to ‘assign 

serial numbers from the top row to the bottom row in the direction of left to right in 

order.’  Using the right icon allows you to ‘assign serial numbers vertically.’ 

o) Select the “Background” menu in the “Template definition” window.  Four items for 

selecting the position where background is set (set background outside of each template, set 

background outside of each spot, select spots for negative control and so forth, and select 

a range of no spot area) will appear.  Select an item.  Press the “Define” button and enter 

setup conditions.  (The conditions you enter differ according to the item.)   

Consider the design of the array to be used and set up the background. 

p) Select the “Anchor/Blank” menu from the “Template definition” window.  Set 

up the template and so on corresponding to the location where no spot has been attached 

as a blank.  (Quantification data are not calculated for this template.)    

[Templates will disappear during the work of step o] or p].  Press the “Refresh” button to  

display the templates, and confirm where the background or the blank has been set up.  If 

any mistake is found, clear the mistake using the “Clear” button and set the items again.] 

q) To save the created template, select “Save as...” from the “File” pull-down 

menu in the upper portion of the “Template definition” window, and save the template  

as a file name. 

8) Click the “OK” button in the “Template definition” window.   (Note: When 

a new template has been created, if you perform this operation before saving the template,  

the template will be lost.)  The “Image view” window remains and the “Sample” toolbox 

appears at the bottom left of the screen when the “Template definition” window and 
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“Alignment” tool box have disappeared.   

[If you want to return to some step and perform the work again, you can return to each step 

by operating the arrow head buttons in the lower left portion of the “Run: [ArrayMacro]” 

window.] 

9) Move the cursor onto the image of the “Image view” window (the cursor will 

change into a square cursor consisting of four arrows) and click the image.   

The calculation of fluorescent intensity will start.  The data list is displayed in the “Data” 

window behind the “Image view” window.  

10) You may find “spots that cannot be used as data” in the array image because of dust or 

background.  In such a case, you can make a distinction the “spots that cannot be used 

as data” by putting a mark (or a “flag”) in the “Image view” window after the calculation  

has been completed.  First, click the “Flag” icon (a red V character with a small 

black rectangle), the second icon from the right in the “Sample” toolbox.  The shape of  

the cursor will change into a red V character.  Then, click the template correspond ing  

to each spot.  The template will automatically turn red.  A “flag” has been attached to  

the spot.  A “flag” is also attached to the box corresponding to the spot in the data list 

on the “Data” window.  

11) Select the “File” menu from the pull-down menus at the top of the screen.  Then, 

select “Save as...” from the “File” menu to save the file as a name.  Both the final 

image and the data list are saved in the file format specific to ArrayVision.  In addition, 

select “Export” from the “File” menu, give the same file name that the two formers have, 

and save the file in the text format.  In this case, only the data list is saved as a text file, in 

addition to the data list saved in the ArrayVision file format.   
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9. Others  

 

Confirmation of “reproducibility”:  

After completion of quantification of the intensity of fluorescence, examine  

the “reproducibility” of the data in the glass sides.  First, export a table of the results of  

the spot fluorescence intensity measurements as a text file.  Transfer this file to a 

spreadsheet software such as the Excel and scatter plot the data of the left and right spot 

set on each glass slide.  The data are judged to be “reproducible” when the quantified 

intensity of fluorescence is in a range from 0.5-2 times (or 1/3 – 3 times).   

Take one of the following steps when the microarray data have shown values above or 

below this range: (1) After the subsequent comparative analysis of the microarray data 

between RNA samplesto confirm the results of the comparative analysis; 

(2) If the “reproducibility” of the data from a piece of 

glass slide is very low (e.g. the scattered plot shows round shape.), 

we recommend performing another exeriment using the same RNA sample.   

 

Normalization:  

Generally, the median value is used, or global normalization is performed.  When 

a positive control (or positive controls) is used as reference for normalization,  

the normalization often turns out to be unsatisfactory.  It is ideal to find 

multiple house-keeping genes (or their cDNAs), the expression quantities of which never 

change, from the probes on the array you used as internal positive controls and  

to use their signals for the normalization.  In this case, you have to find  

the house-keeping genes in each experiment as references for normalization.   

We do not use these positive controls as reference for normalization.  These  
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positive controls are useful to examine whether microarray experiment have been 

successful.  In our rice cDNA Array, insert DNA of a porcine EST clone that does not 

cross hybridize with rice cDNA is spotted as a positive control clone  

(external positive control).  And, in the preparation of the targets of hybridization, 

we simultaneously perform reverse transcriptase reaction by mixing cRNAs of  

these clones from porcine sources (in vitro transcript) with each plant RNA sample.   

Therefore fluorescent signals of positive controls can be obtained as image data with 

signals of rice cDNA clones.  

 

Comparative analysis of microarray data between samples: 

Generally, the quantity of transcription is judged to have increased 

when the ratio of the intensity of fluorescence between the data compared is “2 or 

greater” and to have decreased when it is “0.5 or smaller” (sometimes use “3 or greater” 

and “1/3 or smaller”).  You have to validate microarray data using other methods such 

as RT-PCR and Northern analysis because these criteria are groundless from a 

statistic viewpoint.   

The simplest method for comparative analysis is to export data to spreadsheet 

software such as the Excel, as mentioned above, and to compare quantified data 

of the fluorescence intensity.  The above-mentioned software (the Array Gauge and  

the MicroArray Suite) has functions of comparative analysis.  Although not 

introduced here, several pieces of software are commercially distributed for 

comparative analysis such as the Spotfire, which links reciprocally each point 

on the scatter plot with gene information on the array, and the GeneSpring, which 

can perform comparative analyses using statistical techniques such as  

principal component analysis.   
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Summary 

This article is a collection of protocols concerning the preparation and use of rice cDNA 

microarrays primarily used in the microarray project.  It includes  

protocols for the preparation of a large quantity of cDNA for microarrays, method for  

the use of the spotter, preparation of targets (method for fluorescent labeling of RNA),  

hybridization, washing of glass slides, scanning of fluorescent signals, and quantification of 

image data.  This collection of protocols will serve as a guide for microarray experiments  

and will help in the understanding of the microarray for the participants in this project and 

investigators interested in the microarray.   

 

 

Reference books 
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